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The Data tab is found in the spatial ribbon of all our spatial products:

s Data View Draw Edit Selection Tools Utilities RouteXL surfaces 2 Search
r— E’ Add Google maps == Add layer 0 Properties I I m Save All Laver Data =4 Relations
Add Bing maps Data EN] Load Offiine Layers =%} Database Browser
Open add subl Save Current Layer Data
[% RecentFiles ~ = SUDAYEr | g Pivot Data 11 synchronize Offine Layers [S] Xml Browser
File Add Layer Layers

Here you can do various things. We will take up each section of the tab:

File

r_ a’ Add Google maps

Add Bing maps
Cpen |
[2] RecentFiles ~

File




Open is where you can load many different files into the spatial product; these
files can be brought in by just dragging and dropping as well:

r— F"f Add Google maps

:l Add Bing maps
Cpen §
Recent Files ~

File

ﬂ Choose layer or data to load
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File name: v| All spatial Files (*.%) ~

This can also be done via the shortcut toolbar:

Data View Draw Edit Selection Tools Utilities

X OSelected (8] [ 1 -

Once you have loaded files and maybe gotten rid of them you can then easily
reload those files by dropping down on Recent Files and there will be a list of
the file paths of recent files you have loaded, and you can just click on the de-

sired one and it will be loaded without you having to browse to its location
again:
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Open
Recent Files [

. P" Add Google maps = Add layer o Properties I=I ﬁ Save All Layer Data g} Relations
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To add Google or Bing maps as a background map in your scene, simply click
on Add Google maps or Add Bing maps. To remove these simply click on

them again to toggle them off:
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This can also be done via the shortcut toolbar:

View Diraw Edit Selection Tools Utilities

x 0 Selected & = -

Add Layer

= Add layer
= Add sublayer

Add Layer

To add a new layer click Add layer, it will then prompt you to set its properties,
when you are done click OK and it is added (for full data on this properties box

refer to the Layer Properties Guide):

= Add layer

= Add sublayer

Add Layer



https://primethought.biz/help/spatialvu/layer_properties/

Mew Layer

General Description: |New Layer
Data Display Layer (Will render on Map, otherwise just holds data) Reload
Styling Display from Scale: 0= to: & 000 000 000 -
Text Transparency: — |} +
e Selectable Snapable [ ] Editable ] Includein legend [] Background layer
Links [ Read Only [ ] Data Read Only
Prajection Publish Publish Readonly Fublish Data Readonly
Input Transform Mnemanic Display
Event Scripts Image: Change Clear
Editing
All Properties
Colour Palette
ooy Cancel
Layers Pox
Description

PO B Mew Layer

LI Google Roads




To add a new sublayer first make sure you have the layer selected in the Layer
Description box that you would like to make a sublayer for, then click Add sub-
layer, you are then prompted to set its properties, when done click OK and it is
added (for full data on this properties box refer to the Layver Properties Guide):

Layers BOX

Description
| @ & Mew Layer2
ak B Mew Layer
LI Google Roads

= Add layer

= Add sublayer

Add Layer
Mew Layer >
General Description: |New Layer
Data Display Layer (Will render on Map, otherwise just holds data) Reload
Styling Dizplay from Scale: 0= to: & 000 000 000 -5
Text Transparency: — |} +
e Selectable Snapable [ ] Editable ] Includein legend [ ] Background layer
Links [ Read Only [ ] Data Read Only
Praojection Publish Publish Readonly Fublish Data Readonly
Input Transform Mnemanic Display
Event Scripts i e ——
Editing

All Properties

Colour Palette

Aoy Cancel
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Layers B oX

Description
|| @ % New Layer2

VJ ® % MNew Layer

; IR T New Laye
..[| L8 4 Google Roads

A new layer can also be added via the shortcut toolbar:

Edit Selection Tools Utilities

X 0 Selected [ = -

Layers
O Froperties I I k=] save All Layer Data =# Relations
Data Bl Load Offine Layers =) Database Browser
Sawve Current Layer Data
=== PivotData 11 Synchronize Offfine Layers Xml Browser
Layers

To view the properties of a layer make sure to have the layer selected in the
Layers Description box and then click Properties, this will bring up the Layer
Properties box (for full data on this properties box refer to the Layer Properties
Guide):
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Layers BoXx

Description

1 [ ] & Mew LEI'!.I'EF

L 1 % Google Roads

H ke save All Layer Data = Relations
Data Bl Load Offine Layers =0} Database Browser
Save Current Layer Data
=== Pivot Data 11 Synchronize Offine Layers ¥ml Browser
Layers

Layer Properties - Mew Layer >
General Description: |New Layer
Data Display Layer {(Will render on Map, otherwisejust holds data) Reload
Styling Display from Scale: 0k to: & 000 000 000 ==
Text Transparency: = |} +
R Selectable Snapable [ ] Editable [ Include in legend [ ] Background layer
Links [ read Only [] Data Read Only
Projection Publish Publish Readonly Publish Data Readonly
Input Transform Mnemonic Display
Eveat Erme Image: Change Clear
Editing
All Properties
Colour Palette
Apply Cancel

The Layer Properties box can also be accessed by right clicking on the desired
layer and then clicking Properties:



Layers FoX%

Description
Properties

_ 5
Wiew Data...

lzolate

AT [P S

Zoom fit

r
[ =4

Remove layer

B X

Save 3

To view the data grid of the layer first make sure to have the layer selected in
the Layers Description box, then click on Data and it will bring up the Layer
Data Grid for the layer (for full data on how this data grid works refer to the

Layer Data Grid Guide):

Layers PoOX

Description
PRI B ] ew Layer

L[] L8 @ Google Roads

O Properties I I ke save All Layer Data =4 Relations

Data Eh} Load Offline Layers =0 Database Browser
Save Current Layer Data
=== Pivot Data 1} synchronize Offline Layers E| Xml Browser

Layers
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Layer Data: Mew Drawing

E- Main
| Filter Graphics | 5% Inplace v O Zoom W Highlight Al Copy EeT
: B i Print
Columns 0 Delete :O: Zoom and Highlight [} Un Highlight Al : : Un Highlight Selected & Copy Himl
5% Pivot
s Refresh (& Properties | M Pan [aZ] Highlight Selected i Export to Excel = © e
Filter Edit Selection Output -
Drag a column header here to group by that column ,C'

jin} Description

Point2

Point3
Point4

[T R T TUR N R Y

Point3

This can also be accessed by right clicking on the desired layer and clicking
View Data:

Layers PoX%
Description
13 Properties
|ﬁ View Data...
Loy
E Izolate

EQ] Zoom fit
. Remove layer

ﬁ Save »

Pivot Data

You can view a pivot of your layer data by clicking on Pivot Data (first make
sure to have the desired layer selected in the Layers Description box), this will
bring up the Pivot dialogue where you can design your pivot and do various
other things with it:
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Layers BoXx

Description

A R ] MNew Layer

L 1 % Google Roads

o Properties

Data
Pivot Data

I I led save All Layer Data

Save Current Layer Data

Ehl Load Offline Layers
1l synchronize Offine Layers

Layers

=4 Relations
=0 Database Browser

¥ml Browser

Home File Chart

r9 /O g g Auto Zoom [

Selectin Zoom Selected  Addto  Remove from  auto Selectin graphics [

Pivot: Mew Drawing

= )

Add Field Manage

+=

Graphics Selection  Selection
Tasks Fields
Dirnin Filter Fielde Here
Geometry D Description Volume <Count>

Drop Data Items
Here

Drop Row Fields
Here

Grand Total

Grand Total

0.9

0.6

0.3

Drop Data Items

Drop Column Fields Here

I Grand Total

To create your pivot, drag and drop the fields of your data to be row, column or

data fields:
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Home File

Chart

o PO [ & e

Selectin Zoom Selected Addto  Remove from putg Select in graphics

o =

Drop Data Items
plere Drop Column Fields Here

Dr cieerip gy

Hi =rand Total

L ere :[} T

Grand Total Drop Diata Items

Add Field Manage
Graphics Selection  Selection
Tasks Fields
| Diran Filter Fislds Hare
| Geometry || jin} || Description T| valume || <Count>

Grand Total

I Grand Total

Home File

Chart

ad P g [ sz

Selectin Zoom Selected Addto  Remove from putp Select in graphics
Graphics Selection  Selection

Tasks

R 1=

Add Field Manage

Fields

|_Dmn_EiJ.h=r Fielde Hers

| Geometry | | <Count> |

| Volume | | D - |

| Description & | i} | 1

Pointd 100

Point1 250

Faint2 300

Point3

Point4

500

0.8

0.6

0.4

0.2

0
Grand Total
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Hovering over any one of the column headers you will see a filter symbol which
if you click on will allow you to do filters on that field:

Volume D a T
%Iues Numeric Filters
Description & i Grand Tota
Pointi - 200
Enter text to sea
Pa 20
(Al
Point2 a 50
Faint3 1 73
Pint4 2 a] 100
Grand Tota 3 o 445
a2

Furthermore, clicking once on a column header will sort it ascending and twice
will sort it descending, as indicated by an upwards or downwards arrow:

oint2 30 30
Point3 73 75

oint4 100 100
Grand Total 200 20 50 75 100 445

When you click on a row in the pivot, the chart below will display data for it:
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Pivot: Mew Drawing

Home File Chart

ad P [agd [d oz =

Selectin Zoom Selected Addto  Remove from  aytp Select in graphics Add Field Manage
Graphics Selection  Selection

Tasks Fields -

|_Dmn_Ei.|.ter_Einlr| Hera

| Geometry || <Count> |

Volume | | ID & |
Description a 1] |1 |2 |3 |4 |5 |6 |? |8 |9

Pointd

I

,_.
=
=l

Pointl [, 250

i g o

Point3 400

Point4 500 E

[«1 ]

230 I Foint:
200
150
100

50

Once you have selected a row in your pivot you can highlight and/or zoom to

that row in graphics by clicking Select in Graphics and/or Zoom Selected.
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Home File Chart

ad P |lagd [ad awme [ @ =

Selectin Zoom Selected | Addto  Remove from  autp Selectin graphics [ | Add Field Manage
Graphics Selection  Selection

Tasks Fields -

| Drnn Filter Fields Here

| Geometry | | =Count> |

| Volume | | ID & |

|Descripti0n & |g |1 |2 |3 |4 |5 |6 |? |8 |9

Pointd 100

Point1 250

Point2 300

Point3 400
Point4 500 |Z|

[« [+]

250 I Fointt

200
150
100

50
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Main View =

{=) Ddfloroaat

If you have already selected an element in graphics and you want to select an-
other element and add that to the selection, select the row in your pivot and then
click Add to Selection:
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Home

Graphics

File

a P

Selectin  Zoom Selected

Chart

g g Auto Zoom ||

Add to lRemove from  Autg Select in graphics
Selectionl] Selection

Tasks

0

_! +=
Add Field Manage

Fields

Oirnn Filter Fislds Hare

| Geometry

|| <Count> |

| Volume

o= |

Description a 0 | i | 2 | 3

Point0

100

Pointl

250

Point2

300

Point3
Point4

400

|
=
=

L]

400

300

200

100

M roint3

= i
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To remove an element from selection, select the row in your pivot and then
click Remove from Selection:

Pivot: Mew Drawing

i /C) g g Auto Zoom i =

Selectin Zoom Selected Add to §Remove fromll aito Select in graphics Add Field Manage
Graphics Selection | Selection
Tasks Fields -

If you want rows to be automatically selected and/or zoomed to in graphics
when you click on them, tick on Auto Zoom and/or Auto Select in graphics:

Pivot: Mew Drawing

Home File Chart

i /C) Ig Q Auto Zoom  [v i =

Selectin Zoom Selected Add to  Remove fromfl auto Selectin graphics " Add Field Manage
Graphics Selection  Selection

Tasks Fields -

Diron Filter Fislds Here

Geometry <Count>
Volume D ~

Description & 0 1 2

[
I
w
@
]
@
)

Paint 100

Paintl 250

Paint2 300

Paint3 400

Point4 300 T

400 I roints
300

200

100
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Clicking on Add Field you can add additional fields to your pivot, for example
here I can add a Count field:

Pivot: New Drawing

Home File Chart

ad P hd [ad oz ==

—
Selectin Zoom Selected Addto Remove from ayuto Select in graphics
Graphics Selection  Selection

Add Field Manage

Tasks Fields -

| Diron Filter Fields Here

| Geometry || <Count= |

'v'olurne| |IDA|
pwows o [ T

Faintd 100

Fointl 250

Point2 300

Point3 400

500 [~]
[«] L]

Point4

400 I roints
300

200

100

Choose columns ﬁ

0K || Cancel |

19



Pivot: New Drawing

Home File Chart

Selectin Zoom Selected Addto Remove from Ayt Select in graphics
Graphics Selection  Selection

Tasks Fields

[iron Filter Fislds Hers

Geometry =Count>

Volume ID &

Description & 0 1 2

[
I
w

Point0 100

Pointl 250

Point2 300

Point3 400

Point4 500

400
300
200

100

i /O Ig Ig Auto Zoom [ i =

. Add Field Manage

I Foint3

To manage your fields click Manage and this will bring up the Manage Field
dialogue where you can edit things about your fields for example whether you

want a Sum or Max etc. to be done:
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Home File Chart
E p @ g Auto Zoom E + E
Selectin Zoom Selected  Addto  Remove from  aytg Select in graphics Add Field} Manage
Graphics Selection  Selection
Tasks Fields -
Mirnn Filter Fislde Hars
| Geometry || <Count> |
| Volume | | D a |
S O S S N S O O AN R
W] 0 -
Pointd 100
Point1 250
Point2 300
Point3 400
Point4 500 |Z|
[«] [+]
400 I Foints
300
200
100
0
0 1 2 3 4 5 [ 7 8 g
Manage pivot fields ﬁ
Drag & column header here to group by that column J'-'J
Field Name |Unbu:uund MName |Ca|:utiu:un Area Sort Value Format Summary Type
T A Aadc flc = = = =
Geometry Geometry Filterarea Ascending Sum
D D Columnarea Ascending Sum
Description Description Rowhrea Ascending Sum
& Volume Volume Datalrea Ascending Sum -
<Count:> <Count: Filterarea Ascending Mumeric "nd” Count “
Sum
Min
Max h
Average
StdDewv
StdDevp El
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In the File tab you can export the pivot as a CSV or Excel file by clicking Ex-
port Pivot:

Pivot: New Drawing

Home File Chart

| =

Export Print
Fivot J§ Pivotarid

Export Print -

Dron Filter Fields Here

Geometry <Count>
Volume D -

Description & 0 1 2

o]
ry
w
[}
|
o
o

Pointd 100
Point1 250
Point2 300

Point3

400
Point4 500

Point5 1000

400 I Foint3
300

200

100

¥ Network

File name: | |

Save astype: Comma seperated value files (*.c5v)

» Hide Folders Cancel

You can also print your pivot by clicking on Print Pivot grid and this will

bring up a Preview box for the pivot where you can adjust as needed before
printing:
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Home File Chart

= | k=

Export Print
Pivot [ Pivotgrid

Export Print

| Dron Filter Fields Here

| Geometry ” <Count> |

| Volume | | D |

Description 1] | 1 | 7 | 3 |4 | 5

Paint0 100

Pointl 250

Point2 300

Point3 400

Point4 500

1000 [=]
[«] []

Point5

400 M roint3
300

200

100
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apen B E’ Quick Print @ @ Margins ~ & 801 Thumbnails Previous Page (3 DD =} o E . e
E Options & Orientation + Bookmarks P Next Page O Q «
B save Print Header/Footer Scale — Find o First Many Pages B & v | Close
Parameters v O Size ~ Editing Fields =~ page Pl Last Page =} ~ @
Document Print Page Setup [F] MNavigation Zoom Page Exp Close -
Volume D
Description 0 1 2 3 4 5 6 7
0 0
Paint) 100
Pointl 250
Point2 300
Point3 400
Pointt 500
Paints 1000
Grand Total 100 250 300 400 500 1000 0 0
Page 10f 2 100% —-——-H7 +

In the Chart tab you can print the chart by clicking Print Chart and again the
Preview box will come up where you can adjust as needed before printing:
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fa) o ]
Ere M1, & [S] Header/Footer & R & B0 Thumbnails Previous Page || R aa =} P = - Q
Pnt T | [ scle v B o Bookmarks o P Next Page W " DP Qv q
L] 5 TN Si w I irs any Fages w ose
B save [ margins 10y size Editing Fields ~ Page Ml Last Page a v @ B &
Document Print Page Setup [F1 Navigation Zoom Page.. Exp.. = Close
400
300
200
100
0
0 1 2 3 4 5 6 7 ] 9
-
Page 1of 2 100% - ———1 +

Right clicking in the top of the pivot area brings up a context menu where you
can choose to Reload Data (if anything had been changed in your data):

Dran Filter Eislde Hera

Geometry

[} % Reload Data
Volume ID a _ ) )
=| Show Field List

il | U 1 Y ShowFilter Editor % Grand Total
Paint0 120} 120
Pointl 230 250
Paint2 500 500
Point3 750 750
Point4 1000 1000
Grand Tatal 120 250 500 750 1000 2620

Show Field List will bring up the Field List dialogue where you can manage
the fields of your pivot by choosing which fields go where and which you
would like to hide:

25



Field List =

Drag fields here to hide

Drag fields between areas below:

¥ Filter Area Column Area
Geometry I
Row Area % Data Area
Description Volume
+ | Defer Layout Update Update

And Show Filter Editor will bring up the Filter Editor where you can custom-
ize filters for the fields:
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Filter Editor pod

And &

ins with <enter a value> €

For full data on how the Filter Editor works see Laver Data Grid Guide, Col-
umn Header Area Context Menu

Right clicking on one of the field headers you can Best Fit it so it is sized opti-
mally in the pivot:

Geometry

Volume D a
— % Reload Data

Description & 0D |1
Best Fit [

Order 3

PointD

Pointl

Paint2 Show Field List

Y

FPoint3 Show Filter Editor
Point4 00 00

Grand Total 0020 50 75 00 45

| Geometry
Volume |ID -

Description & g 3 14 Grand Total |

Pointd 200

Pointl 20
Point2 50 50
Paint3 75 75
Point4 100 100

Grand Total 200 20 50 75 100 445
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You can also Order fields if more than one is being used in the column, row or
data areas:

Geometry
volu.. r P b e il | L
% Reload Data

Description #a+ BestFit
Pointd Order e Mowe to Beginning L\\E
Point1 =| Show Field List Mowve to Left
Point2 Y  Show Filter Editor Maove to Right
Foint3 75 3 Mowve to End
Point4 00 4

comd Todol AAC 40

By right clicking in the row and column areas you can choose to sort the rows
by the columns or the columns by the rows:

Geometry

Volume D &

Description 0 1 2 3 - Grand Total
Point0 200
Point1 20
Point2 50 50

Sort "ID" by This Row
Point3 I} 4 73 73
Point4 100 100
Grand Total 200 20 50 75 100 445

Layers Continued

Save Current Layer Data will save the currently selected layer’s data and
Save All layer Data will save the data of all layers (Note: this saves the layers
data only and not any properties you have set for it):

] Data View Draw Edit Selection Tools Utilities RouteXL Surfaces L Search
r— E’ Add Google maps  Addlayer 6 Properties I I Save Al Layer Data =4 Relations
Add Bing maps Data =] Load Offine Layers = Database Browser
Open Add subl Save Current Layer Data
] RecentFiles v = SR Pivot Data 1l Synchronize Offfine Layers E| Xml Browser
File Add Layer Layers

28



Load Offline Layers, Synchronize Offline Layers, Relations and Database
Browser are all covered in manuals of their own listed here: Loading and Syn-

chronizing Offline Layers; Relations; Database Browser:

Utilities RouteXL surfaces

£ search

Draw Edit Selection

Tools

@ Data View

r— E’ Add Google maps
:| Add Bing maps

Open
Recent Files ~

File

= i layer © Properties

= Add sublayer = om i

Add Layer

-

Data
Save Current Layer Data

l&d save All Layer Data =4 Relations
—
| Load Offfine Layers =) Database Browser
T

1 Synchronize Offline Layers| ¥ml Browser

Layers

XML browser

XML Browser will bring up a dialogue that allows you to browse XML files in
an easy way so you can find the data you are looking for and therefore know

what to pull in when adding an XML layer in the spatial product:

Utilities RouteXL

Surfaces . Search

W

Draw Edit Selection Tools

Data Vi

r— F‘” Add Google maps

File

P i
== Add layer o R

Add Layer

-

l&3 save All Layer Data
B} Load Offiine Layers

>| Add Bina maps Data
Open == Add sublayer Save Current Layer Data
Recent Files + == b B Pivot Data 1l Synchronize Offiine Layers I %ml Browser

Layers

=4 Relations

= Database Browser
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) Xml Browser

File Edit Tools

Click on File > Open to bring in an XML file:

g Xl Browser

File | Edit Tools

|,_j" Open  Cirl+0

g
[ Save  Ctrl+5
Save As

= Print Ctrl+P
L

Print Preview

Exit
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Mew folder

A Mame

a Generic_98-311-XCB2011019.xml
A Structure 98-311-XCB2011079.xml

Pe
Pr

bh v <

Status Date modified

@A 2012/05/14 18:10
@A 2012/05/14 18:10

= w

Type

XML Source File

XML Source File

File name: | Structure_98-311-XCB2011019.xml

v| Xmi Files (xml)

Cancel

The file is then opened and its structure is laid out nicely for you to browse, you
can search for things as well using the search bar above:

g Xl Browser

File Edit Tools

Structure_98-311-XCB201101%.xml =

Enter text to search...

Tag
» | Structure

» Header
Codelists
Concepts

L

KeyFamilies

Loaded

Find
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g Xl Browser = O >
File Edit Tools

Structure_98-311-XCB201101%.xml = E

m
i)
m
m
=
=1
%]
m
(U
|
i)

arch... Find

Cui
]

» | Structure “
“  Header
w ID
"08-311-XCB2011019"
Test
Mame xml:lang="en"
Mame xml:lang="fr"
Prepared

Sender id="5TC"

Y Pl N

WOOWONON N

Loaded

Now what you can also do is scan an XML file that may be too large to bring in,
this does not bring in the whole file at once but just allows you to scan for parts
of it that you want. To do this go to Tools > Scan, the Scan dialogue is then
brought up on the right:
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@ Xml Browser

»  Senderid="STC"

LR P R

File Edit | Tools
Structure_98- Sean x -
|Enter text to search... || Find
|Tag
s | Structure E
“  Header
s | ID
"98-311-¥CB2011019"
» Test
»  Mame xml:lang="en"
»  Mame xml:lang="fr" L_|
» Prepared

Loaded

@ Xml Browser — | pod
File Edit Tools
Structure_98-311-XCB201101 ~
- Scan X
|Enter texttosearch... || Find | || gean File: | | [ open |
|Tag | | Restat | | Next |
s | Structure E
“  Header Match Paths
s 1D »
"98-311-¥CB201...
» Test
»  Mame xml:lang="en"
»  Mame xmblang="fF" || |Enter text to search... | | Find
» Prepared

»  Senderid="STC"

LR P R

]

| Tag

Loaded
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Select the file you would like to scan by clicking Open, then below you can
type in the Xpath to match to get out the data you are looking for:

fmh %ml Browser — | X
File Edit Tools
Structure_98-311-XCE201101 - -
Scan FoOoX
Enter text to search. .. Find =can File: |
Tag Restart Mext
s | Structure
»  Header Match Paths
> | Codelists b
» Concepts
»  KeyFamilies
Enter text to search. .. Find
Tag
Loaded
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fm Xl Browser - O e
File  Edit Tools

Structure_98-311-¥CB2011019.xml =

Scan X
Enter text to search... Find Sean File: |C:‘l,l.Jsers‘lMarId]iamund‘lPrimeThnughtE Open
Tag Restart Mext
| Structure -
» | Header Match Paths
» Codelists & Esh'uu:ture:Cu:unu:ept,."sh'uu:b_lre:NamE|

s | Concepts
w | structure:ConceptScheme agencyl...

» structure:Mame xml:lang="en"”

» | structure:Mame xml:lang="fr"

» | structure:Concept id="TIME" ag... Enter text to search... Find
» | structure:Concept id="GEQ" aq...

» | structure:Concept id="AGE" ag... Tag
» structure:Concept id="5ex" age...
?

structure;Concept id="0B5_VA. ..

w

Loaded

Then click Next and the results are displayed below, you can search through
these results with the search bar above as well. Clicking Next again will give
you the next batch of results of that query:
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g ¥ml Browser = O >
File  Edit Tools

Structure_93-311-XCE2011019.xml = =

Scan ¥ X
Enter text to search... Find Scan File:  |C:\Users\MarkDiamond\PrimeThought ¢ Open
Tag Restart
| Structure -
» Header Match Paths
» Codelists b | structure:Concept/structure:Mame
~ | Concepts

w | structure:ConceptScheme agencyl...

» | structure:Mame xml:lang="en”

structure:Mame xml:lang="fr"
structure:Concept id="TIME" ag... Enter text to search...

structure:Concept id="GEQ" ag...

T
structure:Concept id="AGE" ag... -

structure:Concept id="5ex” age... V| structure:Name xml:lang="en

structure:Concept id="0B5_VA...

WOWON OV VW

"Time"

Loaded

Restart will take you back to the top of the file and allow you to scan that path
again from the top or enter in a new path to match:
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g ¥ml Browser = O >
File  Edit Tools

Structure_93-311-XCE2011019.xml = =

Scan PoX
Enter text to search... Find Scan File:  |C:\Users\MarkDiamond\PrimeThought ¢ Open
Tag Mext
s | Structure “
» | Header Match Paths
» | Codelists b | structure:Concept/structure:Mame
~ | Concepts
w | structure:ConceptScheme agencyl...
» | structure:Mame xml:lang="en”
structure:Mame xml:lang="fr"
structure:Concept id="TIME" ag... Enter text to search... Find

structure:Concept id="GEQ" ag...

T
structure:Concept id="AGE" ag... =
structure:Concept id="5ex” age...

structure:Concept id="0B5_VA... [

WOWONON W W

Loaded

Once you have browsed your xml file and found the data you want, you can
now add a new layer and make it XML type and then enter in the appropriate
query to get out the data you want in the layer:
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Data Tab User Guide

MNew Layer

General

. Layer type: |LandXML layer loader

Styling Settings

Text

) Land¥ml File Base Folder:|

Thematics

i Land¥ml File Path: |

et XPath Filter: |

Input Transform ‘Column Mame |}{Paﬂ'| Query

Ewvent Scripts & I

Editing I

all Properties
Autoload [ Fit on Autoload [[] Dynamic Load
Choosepredefined connectionsettings

Colour Palette

[ o< ][ ‘deply || Cance
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Data Tab User Guide

Support

T: +27871354351

support@primethought.biz - primethought.biz
DPrIMEThnughi Kyalami Estate, Midrand, Johannesburg,
Software Solutions 1684, South Afrlca

o st in
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